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Chapter 10

Using Formulas

This chapter describes how to customize:

• Input controls

• Meters

• Bodies

• Global forces

• Frames of reference

Interactive Physics allows you to enter formulas in most places where you would typically enter a number. Formulas enable you to build custom forces and constraints and to dynamically control the behavior of objects. Formulas also serve as the underlying mechanism that links input controls to the simulation. Formulas control the data displayed by meters and output devices.

For a complete listing of the Interactive Physics formula language, consult Appendix B, “Formula Language Reference”.

10.1. Units in Formulas

Interactive Physics automatically keeps track of the unit system associated with formulas according to the following two ground rules:

Rule 1: All formulas and constants are associated with units consistent with the current settings in the Numbers and Units dialog.

Rule 2: If you change the settings in the dialog, Interactive Physics automatically multiplies all constants and formulas by the proper unit conversion factors in order to ensure that the simulation behaves the same way before and after the change.

How Interactive Physics Handles Unit Conversions

Constants 
A constant is defined as a literal number, such as 3.12. Everything else is considered a formula, including expressions that evaluate to constants, such as 3+2.

When the unit system is changed, Interactive Physics updates the values of all constants. For example, entering a value of 10 in a position field measured in meters, and then changing the distance units to centimeters, will cause the value to be automatically changed to 1000 (cm). Note that this change preserves the physical quantity of length in agreement with Rule 2.

Formulas 
When the unit system is changed, all the factors in the formula are multiplied by the proper conversion constants. Suppose the current unit system is SI, and you entered a length of an actuator as follows:
Length: time + 5 [in m]

At time t = 1.0, the length would be 6.0 m.

If you use the Numbers and Units dialog (“Getallen en Eenheden” in Menu “Beeld”) to change the unit system in cm, the equation will automatically be converted to:

Length: 100*(time + 5) [in cm]

Note that the physical quantity is preserved before and after the unit system is changed; without the conversion factor “100”, the length would have been 6.0 cm at t = 1.0, although you would have expected it to be 6.0 m (600 cm).

Furthermore, if the time units were changed from seconds to minutes, the equation would become:

Length: 100*(time*60 + 5) [in cm]

because the variable time now returns the value in minutes (according to Rule 1 above).
Effects 
on Meters 
The values displayed by Meter objects are always associated with the current unit system; if a meter shows 2 m, it will show 200 cm after you change the length unit to cm.
However, in order to enforce the Rule 2 (preserves the physical behavior of the simulation), the values returned by formula references (e.g., output[5].y2) remain the same throughout the unit change. Such behavior is useful especially when you are using meters as variables (see section

10.9. “Using Meters as Variables in Formulas” for details).

For example, suppose you created a time meter output[6] while the current unit for time is seconds. The Properties window for the Meter object shows the variable time in the y1 field. At this point, the formula reference output[6].y1 would return the value 60.0 after 60 seconds elapsed in the simulation.

If you change the unit system to minutes, the meter itself will display the proper values in minutes; it will show 1.0 (min) after 60 seconds elapsed. But the Properties window will show output[6].y1 = time*60.0 so that the reference output[6].y1 will return 60.0 after 60.0 seconds. Without the conversion factor, references to output[6].y1 would return 1.0 after 60.0

seconds because time now returns the value in minutes according to Rule 1.

The meter itself “knows” that the unit change has taken place, and multiplies output[6].y1 by an internal conversion factor of 1/60 (does not appear in the Properties window) to display the data properly in minutes.

If you edit this field, this internal conversion factor is reset to 1.0. Suppose you edited “time*60.0” to “time *60.0” (by inserting a white space between time and “*”), then the meter will display 60.0 after 1 minute elapsed, while output[6].y1 would still show 60.0 after 1 minute.

Notes on 
Precision 
The conversion constants are internally stored with full precision but are displayed with the significant digits given in the Numbers and Units dialog (default is 3 digits). Editing an equation containing conversion constants will cause those constants to be part of the equation string with the precision shown (instead of being internally stored with full precision). Let’s look at our example equation. Even after the units have been changed to inches and minutes, internally the equation is still stored as:
Length: (time sec. + 5) m
yet displayed as:

Length: 12*(time*60 + 5) cm
If we edit the equation, even by just removing blank spaces, it is now internally stored as:

Length: 12*(time min * 60 + 5) cm
Note that if some of the constants had multiple significant digits, modifying the equation could lead to slightly different answers in the simulation. 

Maximum 
Equation Length 
Equations can be up to 255 characters in length. When the conversion constants are added, however, an equation becomes longer and may exceed 255 characters, although the original length you entered was within the bounds. In this case, the equation is displayed as originally entered, and the original unit system is retained for the equation. The units are displayed as three consecutive questions marks, or ??? (which means the original unit system). Editing the equation will change its units to the current unit system.

10.2. Using Formulas to Link Controls to Objects

Whenever you create a control in Interactive Physics, a link is made between the control and the object it affects. For example, to make an object to control a spring constant:

1. Select a spring.

2. Choose Spring Constant from the New Control submenu in the Define menu.

A slider and text box will appear on the screen. This control is

directly tied to the spring, and can be used to change the spring’s

constant.

To see the link between the control and the spring constant:

1. Select the spring.

2. Choose Properties from the Window menu.

The Properties window appears.
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In the area that defines the spring’s constant, you will see the following:

input[10]

When Interactive Physics is running a simulation, it will look for a value to use as the spring’s constant. Instead of using a number, it will use whatever value is being generated by input #10.
Input[10] is the formula name for the value generated by the slider. The formula “Input[10]” was automatically placed in the spring constant field when the slider control was created. If you delete the slider control, the formula will be removed and replaced by the original value of the spring

constant.

You can link input controls to any property you wish by selecting an object and creating a new control from the object menu, or by entering the name of the control (in this case ‘input[10]’) in any field that accepts formulas.

Each control has a minimum and maximum value that you can change from the control's 

10.3. Using Formulas to Customize Objects

You can use formulas in place of numbers in any field of a Properties window. This means that you can attach equations to govern the motion as well as the physical properties of objects during a simulation. For example, you can use formulas to model the mass of a rocket that becomes lighter as its fuel is consumed.

Arithmetic Expressions

Typically, an object keeps its mass constant during a simulation.

You can inspect an object’s mass by selecting the object and then choosing Properties from the Window menu. The Properties window appears to show the object properties, including its mass.

You can click the resize box in the upper-right corner of the Properties window to make it larger. The entry fields expand at the same time, allowing you to enter longer expressions more easily.

A typical rocket might start with a mass of 10,000 kg, (excluding fuel) and carry 10,000 kg of fuel. If the fuel is burned in 100 seconds, and at a constant rate, then the mass M of the rocket can be described as follows:


0 ≤ t < 100 
M = 20000 -100.t


t ≥ 100

M = 10000
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If you were running your simulation for less than 100 seconds, you could simply enter the following into the mass field of the properties window (see Figure 10-2) that defines the rocket’s mass:
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20000 - 100 * time

Figure 10-2
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When you run the rocket simulation, the rocket will progressively become lighter according to the formula you have entered.

Conditional Formulas

If you were running your simulation for more than 100 seconds, you could accurately combine these two equations into a conditional statement as follows:

if (time < 100) mass = 20000 - 100*time

else mass = 10000

You could enter a formula like this using the if function. The if function takes three parameters, each separated by a comma, in the following format:

if (condition,return if true,return if false)

The rocket equations are combined with an if() function as follows:

if(time<100, 20000-100*time, 10000)

Turning Constraints On and Off
The above equation accurately describes the rocket’s mass for all times.

Any forces that are related to the changing mass of the rocket should also correspond to the fact that after 100 seconds, all of the fuel in the rocket is burned up. There are various ways to do this.

In the Properties window of the force you are using for the rocket's thruster, you could enter the value of some force like this:

if (time < 100, 5000, 0)

This means that if time is less than 100 seconds, the force will exert 5000 N. Otherwise, the force will exert 0 N. Interactive Physics also provides an easy way to turn constraints on and off, using the “Active when” field of the force Properties window. To turn the force off after 100 seconds, simply enter 5000 as the value of the force, and enter

time < 100

in the “Active when” field of the Properties window for the force (see Figure 10-3).
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Figure 10-3
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Positioning Constraints Relative to Body Geometry
You can use the formula language to create a constraint whose endpoint positions are defined relative to the geometries of the bodies. For example, you can attach a spring endpoint to the second vertex of a polygon (suppose it is body[3]) by specifying the endpoint coordinate as:

x: body[3].vertex[2].x

y: body[3].vertex[2].y

This way, the endpoint will always remain on the second vertex, even when the size and the shape of the polygon is modified.  Also “Body Fields” in appendix B provides references for syntax.

Customizing Motors and Actuators
To make a sinusoidal driver, draw an actuator, and select the type of actuator as “length”. A default value for the length appears, for example “2.00”. An actuator with a constant length acts as a rod.

An actuator can be turned into a sinusoidal driver by replacing the constant value of “2.00” with a formula. Entering the formula

sin(time) + 2.0

in place of 2.00 will create a sinusoidal driver that changes in length from 1.00 to 3.00 meters every 2( seconds.
10.4. Using Formulas to Define Force Fields

The force field feature of Interactive Physics allows you to model many types of force fields that affect individual objects as well as pairs of objects. Formulas entered in the Force Field dialog are applied as forces and torques to all objects.
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To apply a force of 5 N in the positive x direction to all objects, you would enter 5 in the Force Field dialog and select the Field radio button as shown in Figure 10-4.

Figure 10-4

Force Field dialog

There are times when you want to access the properties of each individual body when applying a custom global force. A good example of this is gravity at the Earth's surface. A general description of the force generated by the Earth's gravitational field near the Earth's surface is given by:

F =  mg 

where 
g = -9.81 m/s2.

This equation results from the more general equation describing the universal gravity:
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Substituting the values of:
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into this equation reduces the problem to .
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Defining Body-dependent Force Fields
To model a gravitational field such as the Earth’s, you can enter the

following equations for a custom global force:
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This equation for Fy includes an identifier called “self”. Self is used to calculate this force for each body in turn, based on the body’s mass.

You also need to select the Field radio button in the Force Field dialog.

The force will be applied as a field to each object individually.

Fx and Fy are the x and y components of the force acting on the center of mass of each body, respectively. T is the torque (in het Nederlands: M is Moment) acting on each body.

Fields Acting on Pairs of Bodies

To model the gravitational attraction between each pair of bodies, you can select “pair-wise” forces. The directions of Fx, Fy, and T correspond to the reference frame created by the connecting line between each successive pair of bodies.

Forces in the x direction are parallel to the connecting line, and forces in the y direction are perpendicular to the connecting line. 
To model gravity in planetary systems, the following equation could be used:

Fx: 
-6.67e-11 * self.mass * other.mass / sqr(self.p - other.p)

Fy: 
0

T: 
0

This is the complete gravitational force definition. A force corresponding to will be applied to each pair of bodies in the simulator.

Note that constants are entered in scientific notation, so the universal gravitational constant is entered in Interactive Physics as: 6.67e-11
For more information, see Appendix B, “Formula Language Reference”.
10.5. Using Formulas to Customize Meters

Meters measure properties defined by formulas. Whenever a meter is created, formula language descriptions are assigned to the meter.

Suppose you created a position meter for a body. You can view the formulas used by a meter in the Properties window as shown in Figure 10-5 below.
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Figure 10-5

Formulas used


in a position 
meter
A meter that measures the position of a body contains the following three formulas:
body[1].p.x

body[1].p.y

body[1].p.r

These formulas refer to the configuration of the object in terms of its

position (x, y) and rotation (r).

You can create custom meters by replacing the default formulas with your own formulas. The title and appearance of a meter can also be altered using the Appearance window.

Further, any meter field can be used in another formula description. See “Using Meters as Variables in Formulas” for examples.

10.6. Specifying Body Path by Position

Typically, the simulation calculations of Interactive Physics automatically governs the motion of objects in your simulation model at run time. Input controls are only effective in defining initial positions of bodies.

But suppose you wish to move a body in your model according to some predefined trajectory that can be described using formulas. You can use the Anchor tool to fix the body, thereby releasing it from the physical interactions computed by Interactive Physics, and assign arbitrary formulas to the object to control the configuration of the object.

1. Select the Anchor tool in the Toolbar.

2. Click on a body.

An Anchor will appear on the body.

3. Select the body with the Arrow tool.

4. Choose Properties from the Window menu.

The Properties window will appear.

5. Type a formula in the x, y and/or rot position fields.

The body will move according to the formula.

To make a body move to the right at a constant velocity, you could type:

time + 2.3

in the x position field. When you run the simulation, the body will start at x = 2.3 and then move to the right. If you type a formula in any of the three velocity fields, the values in the position fields will only be used as initial conditions.

For example, if Vx = time and x = 3.0 , the center of mass of the object will start at x = 3 and then accelerate to the right. At time = 1 it will have a velocity of 1 in the x direction.

10.7. Specifying Body Path by Velocity

You can also prescribe the velocity of a body throughout the simulation with an Anchor.

1. Select the Anchor tool in the Toolbar.

2. Click on a body.

An anchor will appear on the body.

3. Select the body with the Arrow tool.

4. Choose Properties from the Window menu.

The Properties window will appear.

5. Type a formula in the Vx,Vy or Vø field.

To make the center of mass of an object move to the right with constant acceleration, you could type

Time

in the Vx field. 
The center of mass will start at Vx = 0 and accelerate tothe right during the simulation.

To make the center of mass move with a constant velocity, type  

(5.0)

in a velocity field.
Putting the number in parentheses will force the velocity to be a formula.

	NOTE: If the anchored body has a formula in any of its velocity fields, Interactive Physics treats the anchor as a velocity constraint, and the position fields—even if they contain formulas—will be applied only at the first frame.


10.8. Using Formulas to Define Frames of Reference

Interactive Physics can animate your simulation in a non-standard frame of reference. For example, you might want the animation to track a moving object which would otherwise leave the screen at some point. Figure 10-6 shows a simulation of a square tumbling down a wedgeshaped

platform. The reference frame is the background. By default, Interactive Physics uses the background as the frame of reference.

Figure 10-6

A block tumbling

down a wedge

After selecting the square as the frame of reference—that is, view the simulation from the mass center of the square and the square’s orientation—the animation would appear as in Figure 10-7. Note that the anchored wedge appears to rotate during the simulation.

Figure 10-7

Simulation from


the block’s

reference frame

Figure 10-8 again shows the same simulation. But this time, the simulation is viewed positionally from the point in the upper-right-hand corner of the square, yet with the orientation of the background.

Figure 10-8

Simulation from
the block’s

reference frame

without rotation

In order to define the frame of reference shown above:

1. Attach a point element to the body that is to be used as a reference frame.

In the example above, the body would be the tumbling block.

2. Select the point, and choose Properties from the Window menu.

The Properties window appears.

3. Enter the following formula in the ø (angle) field of the point (n is the ID number corresponding to the tumbling block):
-body[n].p.r

The formula specifies the orientation of the frame of reference to oppose that of the body. Now the point will rotate to compensate the rotation of the body.

4. Select the point and choose New Reference Frame from the View menu.

Now the frame of reference is attached to the point. You are ready to run the simulation.

10.9. Using Meters as Variables in Formulas

At times it might be useful to define a “variable” to be used in equations. For example, you may wish to use the expression:

|body[3].p - body[4].p|

(which defines the distance between two bodies) in many places. To avoid repetitive typing, you can define a meter and use it as a variable, or intermediate placeholder.

To define a meter and use it as a variable:

1. Under the Measure menu, choose Time and create a time meter.

In fact, any meter can be used as a variable. For now, we will just use a Time meter and modify it.

2. Double-click on the Time meter.

The Properties window appears.

3. Overwrite the field y1 with the formulas shown in Figure 10-9 below. If necessary, resize the Properties window so you can view the entire text in the formula box.

This step is where you define the variable. In fact, you can use any or all of the output fields (y1 through y4) to define variables.

Figure 10-9

Using a meter field


as a variable
You can now refer to the distance quantity by simply typing:
output[9].y1

(or y2 through y4, depending on which field you used as a variable) instead of spelling out:


|body[1].p - body[10].p|

For example, in order to take the square-root distance between the two bodies, you can type:

sqrt(output[9].y1)

instead of:

sqrt(|body[1].p - body[10].p|)

If you do not wish to see the meter that holds the formula on your workspace, you can hide it. Simply remove the checkmark from the item “Show” in the Appearance window for the meter.
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Een – teken omdat Fy naar beneden moet werken. “Self.mass” betekent dat het voor elk massa-object geldt en dat elk object zijn eigen massa moet nemen.





In dit veld kan elke geldige formule geplaatst worden. Overschrijf eventueel de aanwezige formule.
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